
 

 

SpaceNet 2.5 Quick Start Tutorial 
 

 

 

 

 

 

 

 

Olivier L. de Weck, Paul Grogan 
Massachusetts Institute of Technology, Cambridge, Massachusetts 

Elizabeth O. Jordan, Gene Y. Lee 
NASA Jet Propulsion Laboratory, Pasadena, California 



September 2009   

SpaceNet 2.5 Quick Start Tutorial Page 2 of 43 

TABLE OF CONTENTS  

Introduction ......................................................................................................................................................................... 3 

Scenario 1: Lunar Transportation Architecture ............................................................................................................. 4 

Database Inputs .............................................................................................................................................................. 4 

Scenario Creation ........................................................................................................................................................... 5 

Network Selection .......................................................................................................................................................... 7 

Mission Creation ............................................................................................................................................................. 8 

Simulation and Analysis .............................................................................................................................................. 21 

Scenario 2: Lunar Outpost Architecture ....................................................................................................................... 23 

Database Inputs ............................................................................................................................................................ 23 

Scenario Creation ......................................................................................................................................................... 24 

Network Selection ........................................................................................................................................................ 25 

Mission Creation ........................................................................................................................................................... 26 

Demand Configuration ............................................................................................................................................... 36 

Demands Analysis ........................................................................................................................................................ 39 

Packing and Manifesting ............................................................................................................................................. 41 

Simulation and Analysis .............................................................................................................................................. 42 



September 2009   

SpaceNet 2.5 Quick Start Tutorial Page 3 of 43 

INTRODUCTION 

The goal of this quick start tutorial is to rapidly introduce users to the core concepts of SpaceNet through 
realistic, but notional scenarios. It is organized in two separate scenarios, representing the natural progression 
from analysis to abstraction to analysis.  A user with no prior experience in SpaceNet should allocate at least 
an hour to input and absorb each of the two quick start scenarios – of course much more time could be spent 
delving into the various details and trades diverging from the given scenario. 

The first quick start scenario focuses solely on the transportation architecture of a proposed lunar mission. 
The sole resource that is inspected in great detail is propellant for various propulsive vehicles, and the only 
analysis performed is the capability to achieve the required impulsive burns to reach the destination (Lunar 
South Pole) with a deliverable mass of cargo, and return with a mass of samples. 

The second quick start scenario takes the results from the first, and abstracts the individual impulsive burns 
into a flight, which allows the transport of a specified amount of mass and crew to a destination under the 
assumption that the flight architecture has been shown to close in previous analysis. Using this abstraction, it 
becomes much more feasible to analyze a multi-mission campaign, and the user is introduced to several 
methods of demand modeling and the challenge of manifesting demands. The analysis is focused on closing 
the logistics loop to the Lunar South Pole and maximizing the exploration capability. 

It should be noted that the procurement of data and formatting for compatibility, a large portion of the 
creation of SpaceNet scenarios, is completely omitted from this guide. As is with all systems-level analysis, the 
results are only as good as the inputs (the garbage-in, garbage-out phenomenon), and the acquisition of 
accurate data for complex space systems is always a challenge. Before creating a custom scenario from 
scratch, it is highly recommended to read Appendices A and B of the SpaceNet User’s Guide, which 
introduce users to the representation of data within SpaceNet and how this structure is expressed via the 
database.  

Finally, advanced, highly-customized scenarios will inevitably encounter lapses in the SpaceNet data model, at 
which point custom programming is required. At this point, the user should reference the SpaceNet source 
code and Javadoc for help in this endeavor. 
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SCENARIO 1: LUNAR TRANSPORTATION ARCHITECTURE 

The first quick-start tutorial scenario is focused on analyzing a proposed transportation architecture for a 
return to the moon. This analysis focuses on the propulsive feasibility of transporting a crew of four and a 
specified launch mass from Earth to Lunar South Pole. 

The analysis is very detailed in terms of required delta-v for propulsive burns, including both OMS (Orbital 
Maneuvering System) and RCS (Reaction Control System) capabilities, and for that reason is fairly time-
intensive. For scenarios where the transportation architecture is known to close, it is recommended to use the 
concept of flights, where this level of detail is not required (See Scenario 2: Lunar Outpost Architecture). 

Database Inputs 

For this quick-start tutorial, the required data is already included with the packaged database 
quick_start_1.xls. Relevant information includes the following: 

1. Nodes 
a. KSC (Kennedy Space Center) – Surface node 
b. LSP (Lunar South Pole) – Surface node 
c. PAC (Pacific Ocean Splash-down) – Surface node 
d. LEO (Low-Earth Orbit) – Orbital node 
e. LLPO (Low-Lunar Polar Orbit) – Orbital node 

2. Edges 
a. KSC-LEO (Earth ascent, 1 propulsive burn) – Space edge 
b. LEO-LLPO (Trans-Lunar injection, Lunar orbit injection, 4 propulsive burns) – Space edge 
c. LLPO-LSP (Lunar descent, 2 propulsive burns) – Space edge 
d. LSP-LLPO (Lunar ascent, 2 propulsive burns) – Space edge 
e. LLPO-PAC (Trans-Earth injection, 5 propulsive burns) – Space edge 

3. Resources 
a. PBAN Solid (Solid rocket fuel) – Continuous resource 
b. LH2/LOX (Liquid hydrogen/liquid oxygen cryogenic fuel) – Continuous resource 
c. MMH/N2O4 (Hypergolic fuel) – Continuous resource 

4. Elements 
a. Ares I First Stage – Propulsive vehicle with OMS capabilities 
b. Ares I Upper Stage – Propulsive vehicle with OMS capabilities 
c. Orion Service Module (SM) – Propulsive vehicle with OMS/RCS capabilities (one tank) 
d. Orion Crew Module (CM) – Propulsive vehicle with RCS capabilities 
e. Orion Launch Abort System (LAS) – Carrier element 
f. Ares V Solid Rocket Boosters (SRBs) – Propulsive vehicle with OMS capabilities 
g. Ares V Core – Propulsive vehicle with OMS capabilities 
h. Earth Departure System (EDS) – Propulsive vehicle with OMS capabilities 
i. Altair Descent Module (DM) – Propulsive vehicle with OMS and RCS capabilities 
j. Altair Ascent Module (AM) – Propulsive vehicle with OMS/RCS capabilities (one tank) 
k. Notional Cargo – Notional element to represent cargo 
l. Lunar Surface Samples – Element representing samples returned from the lunar surface 
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Scenario Creation 

The first few steps in creating a SpaceNet scenario include setting global parameters such as the simulation 
start date and loading the data from the desired data source. Additional options for simulation performance 
and constraints are also available from the Edit > Options menu. Please reference the SpaceNet user’s guide 
for details on these additional options. 

1. Launch SpaceNet 2.5 
2. Select File > New to create a new scenario 
3. At the top of the screen, input the following into the scenario header: 

• Name:   Quick Start Scenario 1 
• Start Date:  July 1, 2019 
• Created By:  (Your Name) 
• Description:  A sample scenario analyzing the transportation feasibility of a lunar mission. 

 
Figure 1. The completed scenario header. 

4. To set the data source, click the button marked “Edit” near the top of the screen 
5. Choose the “SpaceNet 2.5 (Excel)” data source type from the drop-down menu 

SpaceNet scenarios use a data source to store information on the network components (nodes and edges), 
customizable resources used in demands, and element templates. The Excel-based data source uses several 
tabs of a spreadsheet to form a simple database. Note that there is no inherent validation built into Excel, so 
data should be checked and validated before using in a scenario. 

 
Figure 2. A view of the 'nodes' table in the quick start 1 Excel database. 

6. Browse to find and load the quick_start_1.xls file 
7. If the data source doesn’t load automatically, check the Nodes, Edges, and Resources and click the 

“Load” button 
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Figure 3. The data source dialog after loading data from the quick start 1 database. 

8. Click “OK” to return to the Network tab 

During the construction of a scenario, if changes are made to the database you must re-load the data source 
to update SpaceNet by re-opening the data source dialog window and clicking the “Load” button. Any new 
nodes, edges, or resources will be automatically added, but existing values will only be overwritten if the 
associated check box is checked. The only exception to this rule is with elements – due to the complex 
structure of element data structures and multiple instantiations with potentially different attributes, only 
previews of elements are loaded initially. The full data structures for elements are only loaded when initialized 
in a Create Elements event. For this reason, there is an additional option to update instantiated elements to 
push updates to already-instantiated elements. 
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Network Selection 

Upon setting the data source, the network should be auto-filtered to match the selected scenario type, a lunar 
scenario by default. In this case, all of the nodes and edges will be used in the scenario. Additional 
information on specific nodes and edges can be accessed by clicking to select an item. 

 
Figure 4. A view of the Network Tab overlaying the scenario network on the Earth-Moon system. 
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Mission Creation 

After setting the network, switch to the Missions Tab. The missions tab is used to define the set of missions 
that operate on the scenario network. Although not a strict definition, a mission usually corresponds to one 
crew rotation or one transport of supplies. 

Each mission is assigned a start date and nodes of reference corresponding to the departure and return (if 
necessary) trips. These nodes are used for internal calculations of transit and surface durations. Mission-level 
demand models can also be assigned to missions and are introduced in quick start scenario 2. Finally, each 
mission has a set of events that are executed to perform mission tasks such as element instantiation, 
transportation, and exploration. 

1. Click the “Add” button under the missions list to create a new mission 
2. Input the following mission information: 

• Name:    Lunar Sortie 
• Start Date:   July 1, 2019 
• Departure Trip:  From: KSC To: LSP 
• Return Trip:  From: LSP To: PAC 

 
Figure 5. The completed mission information. 
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First Launch Stack Instantiation 
The first events will be an instantiation of the first launch stack (Ares I) at KSC. This will be achieved with 
two separate Create Elements events, one to instantiate the launch stack, and the other to instantiate the crew 
inside the crew module. 

1. First, to instantiate the launch stack, click “Add Event” at the bottom of the screen and choose 
“Create Elements” 

2. Add the following elements from the Element Library: 
• Ares I First Stage (Propulsive Vehicle) 
• Ares I Upper Stage (Propulsive Vehicle) 
• Orion SM (Propulsive Vehicle) 
• Orion CM (Propulsive Vehicle) 
• Orion LAS (Carrier) 

3. Click “OK” to save the event 
4. Next, to add the crew members to the crew module, click “Add Event” and choose “Create 

Elements” again 
5. Change the “Create in” field from “KSC” to “Lunar | Orion CM” 
6. Add four copies of the Crew Member element from the Element Library 
7. Click “OK” to save the event 

Figure 6. The completed event to initialize the Ares I 
launch stack. 

Figure 7. The completed event to create the crew in 
the crew module. 
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First Launch 
After instantiating the launch stack at KSC, we will immediately launch it into orbit at LEO using a space 
transport. 

1. Click “Add Event” and choose “Space Transport” 
2. Check all five elements to be included in the launch stack 
3. Provide the burn/stage sequence to achieve the required 9500 m/s delta-v by selecting the proper 

elements and clicking the “Burn” and “Stage” buttons: 
• Burn Ares I First Stage 
• Stage Ares I First Stage 
• Stage Orion LAS 
• Burn Ares I Upper Stage 
• Stage Ares I Upper Stage 

4. Press the “OK” button to save the event 

 
Figure 8. The completed event to 

launch the Ares I stack. 

 
Figure 9. After creating the first space transport, the mission bat chart 

illustrates the transport of the launch stack from KSC to LEO. 
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Second Launch Stack Instantiation 
Now that the Orion vehicles and crew are in orbit, we will instantiate the second launch stack (Ares V), 
including the Altair vehicles, at KSC. Similar to adding crew, this will also require two separate events in order 
to correctly represent a notional cargo element. 

1. First, to instantiate the launch stack, click “Add Event” and choose “Create Elements” 
2. Change the Node to KSC 
3. Change the Time to 1.0 
4. Add the following elements from the Element Library: 

• Ares V SRBs (Propulsive Vehicle) 
• Ares V Core (Propulsive Vehicle) 
• EDS (Propulsive Vehicle) 
• Altair DM (Propulsive Vehicle) 
• Altair AM (Propulsive Vehicle) 

5. Click “OK” to save the event 
6. Next, to add the cargo element, click “Add Event” and choose “Create Elements” again 
7. Change the “Create in” field from “KSC” to “Lunar | Altair DM” 
8. Add a copy of the “Notional Cargo” element from the element library 
9. Click “OK” to save the event 

Figure 10. Completed event to initialize the Ares V 
launch stack. 

Figure 11. Completed event to create the notional 
cargo inside the Altair descent module. 
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Second Launch 
Just as in the first launch, we will immediately launch the second stack into orbit at LEO using a space 
transport. 

1. Click “Add Event” and choose “Space Transport” 
2. Check all five elements to be included in the launch stack 
3. Provide the burn/stage sequence to achieve the required 9500 m/s delta-v by selecting the proper 

elements and clicking the “Burn” and “Stage” buttons: 
• Burn Ares V SRBs 
• Stage Ares V SRBs  
• Burn Ares V Core 
• Stage Ares V Core 
• Burn EDS 

4. Press the “OK” button to save the event 

 
Figure 12. Completed event to launch 

the Ares V stack. 
 

Figure 13. The mission bat chart illustrates the dual launches to LEO. 
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Trans-Lunar Injection, Lunar Orbit Injection 
Now that vehicles from both launch stacks are in low Earth orbit, they can be coupled in future events such 
as the lunar orbit injection transport. Although not presented in this scenario, if you want to model proximity 
operations such as orbit circularization, docking, or undocking, you can use individual “Propulsive Burn” 
events. 

1. Click “Add Event” and choose “Space Transport” 
2. Change the Time to 2.0 
3. Check all five elements (Altair AM, Altair DM, EDS, Orion CM, and Orion SM) to be included in 

the launch stack 
4. Provide the burn/stage sequence for the first burn (3150 m/s, Trans-Lunar Injection): 

• Burn EDS 
• Stage EDS 

5. Click “Burn 2 (RCS)” and provide the burn/stage sequence (2 m/s, mid-course corrections): 
• Burn Altair DM 

6. Click “Burn 3 (RCS)” and provide the burn/stage sequence (2 m/s, mid-course corrections): 
• Burn Altair DM 

7. Click “Burn 4 (OMS)” and provide the burn/stage sequence (950 m/s, Lunar Orbit Injection): 
• Burn Altair DM 

8. Press the “OK” button to save the event 

 
Figure 14. Completed event to 

perform the TLI/LOI transport. 

 
Figure 15. The mission bat chart illustrates the transport of the Altair and 

Orion vehicles to LLPO. 
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Lunar Descent 
Now that the vehicles are in lunar orbit, we can move the crew from the Orion to the Altair, which will be 
used in the descent to the lunar surface. 

1. Click “Add Event” and choose “Move Elements” 
2. Set the “Move to” location to the Altair AM 
3. Check the four crew members (currently in the Orion CM) 
4. Click “OK to save the event 

 
Figure 16. Completed event to move the crew to the Altair vehicle. 

5. Click “Add Event” and choose “Space Transport” 
6. Change the Time to 7.0 
7. Select the LLPO-LSP trajectory 
8. Check the Altair elements (Altair AM, Altair DM) to be included in the transport stack 
9. Provide the burn/stage sequence for the first burn (2030 m/s): 

• Burn Altair DM 
10. Click “Burn 2 (RCS)” and provide the burn/stage sequence (11 m/s): 

• Burn Altair DM 
11. Press the “OK” button to save the event 
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Figure 17. The completed event 

to perform the descent. 
Figure 18. The mission bat chart illustrates the lunar descent of the Altair 

vehicle to LSP. 
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Exploration 
Now that the crew has reached the lunar surface, we can send them on an exploration, and create a notional 
element to represent returnable samples. The exploration of the lunar surface will be accomplished with a 
Crewed Exploration event, which is used to schedule a set number of EVAs. Although not presented in this 
scenario, individual EVAs can also be scheduled with Crewed EVA events. 

1. Click “Add Event” and choose “Crewed Exploration” 
2. Set the duration to 7.0 days 
3. Set the number of EVAs to 5 per week 
4. Select the Altair AM as the Crew Habitat 
5. Check two of the four crew members for EVA 
6. Click “OK” to save the event 

 
Figure 19. The completed event to schedule the 

surface EVAs with two crew members. 

 
Figure 20. The completed event to add notional surface 

samples to the Altair vehicle. 

7. Next, to create the surface samples for return, click “Add Event” and choose “Create Elements” 
8. Set the “Create in” field to Altair AM 
9. Add a copy of the Lunar Surface Samples from the element library 
10. Click “OK” to save the event  
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Figure 21. A view of the missions tab after completing the surface exploration and adding the samples. 
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Lunar Ascent 
After the surface exploration, the crew and the ascent module perform a space transport to rendezvous with 
the command module and service module in lunar orbit. 

1. Click “Add Event” and choose “Space Transport” 
2. Check the Altair AM to be included in the launch stack 
3. Provide the burn/stage sequence for the first burn (1875 m/s): 

• Burn Altair AM 
4. Click “Burn 2 (RCS)” and provide the burn/stage sequence (31 m/s): 

• Burn Altair AM 
5. Click “OK” to save the event 

 
Figure 22. The completed event to 

launch the Altair ascent vehicle. 

 
Figure 23. The mission bat chart illustrates the ascent of the Altair to 

LLPO 
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Trans-Earth Injection 
Finally, to complete our scenario, the crew rejoins the Orion vehicle in lunar orbit, and returns to Earth. 

1. Click “Add Event” and choose “Move Elements” 
2. Set the “Move to” location to the Orion CM 
3. Check the four crew members and the Lunar Surface Samples (currently in the Altair AM) 
4. Click “OK” to save the event 

 
Figure 24. The completed event to move the crew and samples to the crew module. 

5. Click “Add Event” and choose “Space Transport” 
6. Set the Time to 16.0 
7. Select the “LLPO-PAC” trajectory 
8. Check the Orion CM, and Orion SM to be included in the transport stack 
9. Provide the burn/stage sequence for the first burn (612.3 m/s): 

• Burn Orion SM 
10. Provide the burn/stage sequence for the second burn (276.5 m/s): 

• Burn Orion SM 
11. Provide the burn/stage sequence for the third burn (333.6 m/s): 

• Burn Orion SM 
12. Provide the burn/stage sequence for the fourth burn (3.2 m/s): 

• Burn Orion SM 
13. Provide the burn/stage sequence for the fifth burn (3.2 m/s): 

• Burn Orion SM 
14. Provide the burn/stage sequence for the sixth burn (5.0 m/s): 

• Stage Orion SM 
• Burn Orion CM 

15. Click “OK” to save the event 
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Figure 25. The completed event to 
return the Orion vehicle to Earth. 

Figure 26. The mission bat chart illustrates the transport back to the 
PAC splashdown. 
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Simulation and Analysis 

The mission creation process heavily relies on pre-simulation to check for error conditions throughout the 
scenario creating process. Since we were able to create this mission without any errors, the transportation 
architecture closes. 

For more detailed analysis, however, we can run a simulation and inspect the levels of propellant throughout 
the scenario. Note that this scenario does not inspect demand feasibility, so there are no demands to view in 
the Demands tab, nor anything to pack and manifest in the Manifest tab. 

1. Click “Save” to save this mission 
2. Switch to the Simulation Tab 
3. Click the “Simulate” button to run the simulation 
4. Under the “Network History” tab, press the play button to run a basic network animation. Pause the 

animation near July 8, 2019 and select an element in the right-hand part of the screen, to inspect its 
remaining propellant, cargo capacity, and other information. 

 
Figure 27. After simulation, the Network History tab provides a basic animation for the scenario. 

5. Switch to the “Element History” tab, and select the “Altair DM” element. By toggling the visible 
classes of supply to only display COS 1 (Propellants and Fuels), you can track the remaining 
propellant throughout the scenario. 

6. Right-click the chart and choose “Save as…” to save the chart as a .PNG formatted image. This 
capability is inherent in all charts within SpaceNet. 
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Figure 28. The Element History tab allows a visualization of resource levels through the scenario, in this case 

propellant in the descent module. 
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SCENARIO 2: LUNAR OUTPOST ARCHITECTURE 

Using the results of the first scenario, the second quick-start scenario abstracts the transports from the Earth 
to the Lunar South Pole to a single flight, and the same for the return trip. It uses the assumption that the 
transportation architecture is known to close for a delivery payload of 500 kilograms and a return payload of 
100 kilograms for a crew of four to simplify the build-up of a long-duration lunar outpost. 

Also included in this analysis is the knowledge that cargo flights can deliver 12,000 kilograms to the lunar 
surface – the results from which a separate analysis similar to that from the previous scenario has already 
been performed. 

The goal of this next level of analysis is analyzing the surface feasibility, including demands from the crew 
members, demands for spare parts, and the supply chain network used for resupply. If the scenario does 
indeed close, then we then can seek to evaluate the scenario based on one or several Measures of Effectiveness. 

Database Inputs 

For this quick-start tutorial, the required data is already included with the packaged database 
quick_start_2.xls. Relevant information includes the following: 

1. Nodes 
a. KSC (Kennedy Space Center) – Surface node 
b. LSP (Lunar South Pole) – Surface node 
c. PAC (Pacific Ocean Splash-down) – Surface node 

2. Edges 
a. Crewed Delivery – Flight edge 
b. Crewed Return – Flight edge 
c. Cargo Delivery – Flight edge 

3. Resources 
a. Habitat Spare – Discrete resource for notional habitat spares 
b. Power Supply Spare – Discrete resource for notional power supply spares 

4. Elements 
a. Crewed Lander – Carrier representing transportation architecture delivering crew and 

minimal cargo 
b. Crewed Return Capsule – Carrier representing transportation architecture returning crew 

and minimal cargo 
c. Cargo Lander – Carrier representing transportation architecture delivering significant cargo 
d. Crew Member – Crew member 
e. Crew Habitat – Carrier that crew use as an outpost habitat 
f. Power Supply Unit – Element that supplies power to the habitat 
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Scenario Creation 

As in quick start scenario 1, we will first set some global parameters for the scenario, including the data 
source. 

1. Launch SpaceNet 2.5 
2. Select File > New to create a new scenario 
3. At the top of the screen, input the following into the scenario header: 

• Name:   Quick Start Scenario 2 
• Start Date:  July 1, 2019 
• Created By:  (Your Name) 
• Description:  A sample scenario analyzing the feasibility of a lunar outpost. 
• Scenario Type:  Lunar 

 
Figure 29. The completed scenario header. 

4. To set the data source, click the button marked “Edit” near the top of the screen 
5. Choose the “SpaceNet 2.5 (Excel)” data source type from the drop-down menu 
6. Browse to find and load the quick_start_2.xls file  
7. If the data source doesn’t load automatically, check the Nodes, Edges, and Resources and click the 

“Load” button 

 
Figure 30. The data source dialog after loading the data from the quick start 2 database. 

8. Click “OK” to return to the Network tab 
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Network Selection 

Upon setting the data source, the network should auto-filter to the correct scenario type. In this case, all of 
the nodes and edges will be used in the scenario. Note also that this scenario uses flight edges (yellow) instead 
of space edges (red) and no intermediate nodes between the Earth and the Moon. This abstraction will allow 
us to create missions much faster. 

 
Figure 31. A view of the Network Tab overlaying the scenario network on the Earth Moon system. 
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Mission Creation  

After setting the network, switch to the Missions Tab. In this scenario, we will be creating four missions 
instead of just one. An important difference is that any non-reusable mission elements must be removed from 
the simulation. For example, after the crew returns to Earth, they should be removed from the simulation to 
prevent demands from being generated in the Pacific Ocean. 

Mission 1: Automated Check-out 
The first mission will deploy an unmanned lander and return capsule to the lunar surface in preparation for 
future crewed missions. Taking advantage of the abstracted transportation architecture with flight transports, 
this mission will only require two events. 

1. Click the “Add” button under the missions list to create a new mission. 
2. Input the following mission information: 

• Name:    Automated Check-out Mission 
• Start Date:   July 1, 2019 
• Departure Trip:  From: KSC To: LSP 

2. To instantiate the flight vehicles, click “Add Event” at the bottom of the screen and choose “Create 
Elements” 

3. Add the following elements from the Element Library: 
• Crewed Lander (Carrier) 
• Crewed Return Capsule (Carrier) 

4. Click “OK” to save the event 

 
Figure 32. The completed event to instantiate the flight elements. 

5. Next, to transport the vehicles to the Lunar South Pole, click “Add Event” and choose “Flight 
Transport” 

6. Choose the “Crewed Delivery” flight, and check both the lander and return capsule 
7. Click “OK” to save the event 
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8. Click “Save” to save the mission 

 
Figure 33. The completed event to 

perform the flight transport. 

 

 
Figure 34. The scenario bat chart shows the transport to LSP in the 

first mission. 
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Mission 2: 7-Day Crewed Mission 
The second mission delivers a crew of four to the surface. As in quick start 1, the launch stack and the crew 
are created in separate events. Like the previous mission, a flight is used to transport the crew to the lunar 
surface. While on the surface, the crew will participate in scheduled EVAs throughout the mission duration 
before moving to the return module before being transported back to Earth. Finally, the return capsule and 
the crew are removed from the simulation. 

1. Click the “Add” button under the missions list to create a new mission. 
2. Input the following: 

• Name:    7-Day Surface Exploration 
• Start Date:   December 1, 2019 
• Departure Trip:  From: KSC To: LSP 
• Return Trip:  From: LSP To: PAC 

3. Click “Add Event” at the bottom of the screen and choose “Create Elements” 
4. Add the following elements from the Element Library: 

• Crewed Lander (Carrier) 
• Crewed Return Capsule (Carrier) 

5. Click “OK” to save the event 

Figure 35. The completed event to instantiate the 
flight vehicles. 

Figure 36. The completed event to create the four 
crew members in the lander vehicle. 

6. Click “Add Event” and choose “Create Elements” again 
7. Change the “Create in” field from “KSC” to “7-Day | Crewed Lander” 
8. Add four copies of the Crew Member element from the Element Library 
9. Click “OK” to save the event 
10. Click “Add Event” and choose “Flight Transport” 
11. Choose the “Crewed Delivery” flight and check both the lander and return capsule 
12. Click “OK” to save the event 
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Figure 37. The completed event to 

transport the crew. 
Figure 38. The mission bat chart illustrates the flight transport from 

KSC to LSP. 

13. Click “Add Event” and choose “Crewed Exploration” 
14. Set the Duration to 7 days 
15. Set the Number of EVAs to 5 per week 
16. Set the Crew Habitat to the “Crewed Lander” 
17. Check two of the crew members to participate in the EVA and click “OK” to save the event 

Figure 39. The completed event to 
perform the crewed exploration. 

Figure 40. The mission bat chart illustrating the crewed surface 
exploration. 

18. Click “Add Event” and choose “Move Elements” 
19. Set the “Move to” field to “7-Day | Crewed Return Capsule” 
20. Check the four crew members and click “OK” to save the event  
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Figure 41. The completed event to move the crew to the return capsule. 

21. Click “Add Event” and choose “Flight Transport” 
22. Choose the “Crewed Return” flight, check the return capsule, and click “OK” to save the event 

 
Figure 42. The completed event to 

transfer the crew back to Earth. 
Figure 43. The mission bat chart illustrating the transport back to 

PAC. 

23. Click “Add Event” and choose “Remove Elements” 
24. Check the Return Capsule and click “OK” to save the event 
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Figure 44. The completed event to remove the crew from the simulation. 

25. Click “Save” to save the mission 

 
Figure 45. A view of the Missions Tab with the scenario bat chart illustrating the flights of the first two 

missions. 
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Mission 3: Habitat Delivery 
The next mission will deliver the Crew Habitat and Power Supply Unit using a cargo lander. 

1. Click the “Add” button under the missions list to create a new mission. 
2. Input the following: 

• Name:    Habitat Delivery 
• Start Date:   March 1, 2020 
• Departure Trip:  From: KSC To: LSP 
• Return Trip:  From: (blank) To: (blank) 

3. Click “Add Event” at the bottom of the screen and choose “Create Elements” 
4. Add the following elements from the Element Library: 

• Cargo Lander (Carrier) 
5. Click “OK” to save the event 

 
Figure 46. The completed event to instantiate the 

cargo lander vehicle. 

 
Figure 47. The completed event to create a habitat 

and power supply unit inside the cargo lander. 

6. Click “Add Event” and choose “Create Elements” again 
7. Change the “Create in” field from “KSC” to “Habit| Cargo Lander” 
8. Add the following elements from the Element Library: 

• Crew Habitat (Carrier) 
• Power Supply Unit (Element) 

9. Click “OK” to save the event 
10. Click “Add Event” and choose “Flight Transport” 
11. Choose the “Cargo Delivery” flight, check the cargo lander, and click “OK” to save the event 
12. Click “Save to save the mission 
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Figure 48. A view of the Missions Tab with the scenario bat chart illustrating the flights of the first three 

missions. 
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Mission 4: 14-Day Crewed Mission 
This next mission will extend the surface duration from one week to two weeks. Since we have gone through 
the work of creating a basic mission, we can simplify the rest of the mission-creation processes by copying 
the format for one mission and making small changes. 

1. Select the 7-Day Surface Exploration mission and click “Copy” 
2. Change the following mission information: 

a. Name:    14-Day Surface Exploration 
b. Start Date:   July 1, 2020 

3. Next, we want to move the crew members to the newly-delivered habitat after arrival. Since new 
events default to occur immediately after the previously selected event, select the first flight 
transport, click the “Add Event” button, choose “Move Elements”  

4. Set the “Move to” field to the habitat, check the four crew members 
5. Click “OK” to save the event 

 
Figure 49. The completed event to move the crew to the habitat. 

1. Select the “Crewed Exploration” event, and click the “Edit” button  
2. Set the Duration to 14 days 
3. Set the Priority to 2 (so the event executes after the crew move to the habitat) 
4. Select the Crew Habitat, check two of the crew members as participating in the EVAs 
5. Finally, click “OK” to save the event 
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Figure 50. The completed event 
expanding the exploration to 14 days. 

Figure 51. A view of the Missions Tab after editing the exploration, 
which introduced an error. 

Note that at this point, an error message occurs, notifying that the crew member was not found at the Lunar 
South Pole (the error message can also be seen by opening the exploration event window). To correct this 
error condition, we will edit the timing of the remaining events of the mission. 

6. Double-click the time for the Move and change it to 21.50 
7. Double-click the time for the Flight Transport and change it to 21.50 
8. Double-click the time for the Remove Elements event and change it to 27.00 

 
Figure 52. A view of the Missions Tab after the errors have been corrected. 

9. Click “Save” to save the mission 
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Demand Configuration 

Now that the basic mission architecture is set up, we can more closely inspect the feasibility of the scenario 
from the demands perspective. First, however, we must add demand generation into the scenarios. This will 
be accomplished with two methods: mission-level crew consumables demands and element-centric sparing. 
The mission-level demands will be added to the crewed missions first. 

1. Select the “7-Day Surface Exploration” mission and click “Edit” 
2. Click the “Add Demand” button and select “Crew Consumables Demand Model” 
3. Click “OK” to add the demand model and click “Save” to save the mission 

 
Figure 53. The inputs for the 7-day mission. 

 
Figure 54. The demands for the 7-day mission. 

4. Select the “14-Day Surface Exploration” mission and click “Edit” 
5. Click the “Add Demand” button and select “Crew Consumables Demand Model 
6. Click “OK” to add the demand model 
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Figure 55. The inputs for the 14-day mission. 

 
Figure 56. The demands for the 14-day mission. 

Now that the mission-level consumables demands are in place, we will add the element-level spares demands. 
This is accomplished by reconfiguring the elements to new operational states that have been assigned demand 
models. In this scenario, the Crew Habitat and the Power Supply Unit have demands for spare parts in their 
Active state, and have no demands in their Dormant state. You can view the demand models associated with 
each state by opening the Create Elements event where the element was instantiated and selecting “Edit,” 
choosing a state, and choosing “Edit State.” 

 
Figure 57. The edit element dialog for the habitat 

element. 

 
 
 
 

Figure 58. The edit state dialog for the habitat's active 
state. 

7. Select the first Flight Transport, click “Add Event” and choose “Reconfigure Group” 
8. Set the new state to be “Active” and check the habitat and power supply elements 
9. Click “OK” to save the event 
10. Select the “Crewed Exploration” event, click “Add Event” and choose “Reconfigure Group” 
11. Set the new state to be “Dormant” and check the habitat and power supply elements 
12. Click “OK” to save the event 
13. Click “Save” to save the mission 
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Figure 59. The completed event to turn on the habitat 

and power supply upon arrival. 

 
Figure 60. The completed event to turn off the habitat 

and power supply before departure. 
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Demands Analysis 

After enabling the scenario demands, switch to the Demands Tab. In this module, you can configure the 
demands settings before continuing to packing, manifesting, and simulation. There are several visualizations 
to aid in the demands analysis. 

• Scenario Feasibility – Shows the demands and delivery capability at a node. In the cumulative view, 
if the red demands line crosses the green remaining capacity line, the scenario is likely infeasible at 
that node. In this scenario, there appears to be infeasible demands during the second mission, 
although a thorough packing and manifesting analysis is required for specifics. 

 
Figure 61. The scenario feasibility chart provides a quick check for demanded  

mass and delivery capacity to a specific location. 

• Supply Network – Illustrates the aggregated demands and transports through the time-expanded 
network. The thicker the green line, the more remaining delivery capacity to a location. The larger the 
blue dots, the more aggregated demands there are at that point. 

 
Figure 62. The supply network chart provides a multi-node time-expanded  

visualization of demands and delivery capacity. 
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• Demands by Element, Mission, and Location – Shows the demands broken down by element, 
mission, or location. If only one object is selected, the demands are displayed over time. 

• Commonality Analysis – If the scenario elements contain common parts, scavenging can be used 
to satisfy some of the sparing demands. 

• Repairability Analysis – If the scenario elements contain repairable parts, a trade of crew time can 
be made to satisfy some of the sparing demands. 
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Packing and Manifesting 

After inspecting the scenario demands, switch to the Manifest Tab. To quickly manifest the demands for 
this scenario, we will be using the auto-manifest option. 

1. Click the “Reset Manifest” button to reset the aggregated demands 

 
Figure 63. The manifest tab displays a list of aggregated demands, packed demands, and manifested 

demands. 

2. Click the “Auto-Manifest” button to automatically pack the demands into logistics containers and 
manifest the logistics containers onto the first possible flight after the demand (carry-along 
preference) 

 
Figure 64. Auto-manifesting performs a brute-force process to try and manifest the demands. 
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Simulation and Analysis 

After manifesting the demands, switch to the Simulation Tab. 

1. Click the “Simulate” button to run the simulation 
2. Note: Since all the required demands did not get manifested, several simulation errors will occur due to resource 

insufficiencies. Under normal circumstances, this would trigger a revision of the missions to close the logistics loop. 
3. Under the “Network History” tab, press the play button to run a basic network animation. Pause the 

animation near December 25, 2019 and select an element in the right-hand part of the screen, to 
inspect its cargo capacity, state, and other information. 

 
Figure 65. The network history provides a visualization of the scenario network during simulation. 

4. Under the “Measures History”, choose the Relative Exploration Capability (REC) measure to track 
its evolution over time. Note that this could be improved by creating science elements (COS 6) for 
the missions to use the excess cargo margin. 
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Figure 66. The measures history provides time histories of the various measures of effectiveness. 

5. Under the “Location History”, choose the LSP Node to track its history over time. Deselect COS 8 
(Habitation and Infrastructure) and COS 9 (Transportation and Carriers). Note the increase of COS 
5 (empty containers) and cycling of demand supply and use. 

 
Figure 67. The location history provides time histories of the resources located at various points. 


